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Apercu général On cherche a créer des briques a

partir du maillage, puis a placer ces

briques séparément sur une grille.

% ENSAM-S4-MORPHO.3dm

1. Décaler chaque face
du maillage pour créer
un extrados

% ENSAM-S4-MORPHO.3dm

2. Aplanir chaque face
de I'extrados

4. Créer une grille sur
laquelle on étalera les
briques

MORPHOLOGIE - Etude d’une coque simple

% ENSAM-S4-MORPHO.3dm

3. Créer des briques a
partir de chaque couple
de faces intra/extrados

% ENSAM-S4-MORPHO.3dm

% ENSAM-S4-MORPHO.3dm

5. Positionner toutes les
briques dans une case
de la grille
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Installer Weaverbird

Weaverbird est un add-on officiel qui s’installe
directement depuis Rhino : lancez la commande
GestionnairePacks et cherchez Weaverbird

pour l'installer.

MORPHOLOGIE - Etude d’une coque simple

Liste de I'ensemble des composants de
Weaverbird sur GrasshopperDocs, un site
qui référence les composants et extensions.

@ [ ] Gestionnaire de packs
Enligne | Installé
[Q weaver| 0] &l

Weaverbird v0.9.0+1-yak-and-mac Nom Weaverbird

Weaverbird is a Grasshopper add-on Teéléchargements 453615

for mesh subdivision, editing and Auteur Giulio Piacentino
Installé
Version 0.9.0+1-yak-and-mac
Date de publication Tuesday, 27 February 2018

http://

Url www.giuliopiacentino.com/

Inclure les versions préliminaires

weaverbird/
Description

Weaverbird is a Grasshopper add-on for mesh
subdivision, editing and construction. To use the
add-on, you must read and accept the license
agreement in the license.rtf file.

Installer

Annuler Appliquer

Wb Create| Wb Define

PO AVLUKOX ¥ 9 QAPA DT

Wb Extract

A
B
L

Join Meshes and Weld
Dual graph

Reroute Faces

Dye Reroute Faces by Pattern
b4 Unify face windings
@i Vertices Component
O  Face Polylines
B  MeshEdges
Z Naked boundary
Wb Define

S e 06

Mesh Antiprism

Mesh Pyramid

Mesh Prism

Mesh Dipyramid

Mesh Mesh Icosahedron

Polylines Dodecahedron

v ROTATERY

Wb SubD Wb Transform
0 Loop Subdivision :ﬁ Offset Mesh
a Inner Polygons Subdivision W Sierpinski Carpet
A Sierpinski Triangles Subdivision @ Mesh Window
‘ Catmull-Clark Subdivision W Picture Frame
o Split Polygons Subdivision v Bevel Edges
a Midedge Subdivision 5 Stellate/Cumulation
A Split Triangles Subdivision ' Mesh Thicken
A Constant Quads Split Subdivision v Bevel Vertices
Wb Smoothen Wb Create
? Laplacian Smoothing B Mesh From Lines (Weave Back)
9 Blur Mesh @ Tile

%) LaplacianHC Smoothing

Weaverbird est un add-on qui étend les

fonctionnalités de gestion des maillages de
{?.rneehnrr_\ppr 1 pnrmnf notamment de les

subdiviser, de les lisser, les épaissir, etc.
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Démarrer un nouveau fichier GH

Commencez par ouvrir votre précédent fichier RHINO,
pUiS votre précédent fichier Grasshopper.

Vous allez ensuite faire « Enregistrer sous... » : vous

MORPHOLOGIE - Etude d’une coque simple

Les géométries manipulées dans Grasshopper
sont toutes nativement dépendantes :

- elles dépendent soit du fichier Rhino avec
lequel elles sont liées (set one/multiple)

- le reste du temps, elles dépendent de
'ensemble des composants présents en amont

créez un nouveau fichier avec un nouveau nom, etc.

et tout le contenu du précédent fichier.

Pour alléger le calcul, on va autonomiser le
dernier composant du fichier du TD2, contenant

juste le maillage.

®@0e e New Document ®’N
E| Maanétiy Open Document... #$0
Sar . Recent Files >
D E‘;’ Q g [: Save Document ¥S
Save Document As... 4¥8S
Save Backup X¥S
a Export Quick Image... |
koo v '[\"v D-v Export Hi-Res Image...
& > 0@ Document Properties...
v 8 7 v
i %' g' 0' k= Create User Object...
@ % “ E& Insert Cluster Into File...
L
B % Y .
=]
E(F' EI% W 9' iCloud
ooo
g:: E' WV /' Emplacements
) Tags
Oy

@ Grasshopper - Edit View Display Solution Window

(en langage GH, on internalise les données)

Repérage in|

Solver

sition des fenétres

50 @ 5

ssus |

Face

Explode Tree FC-Maillage coque

Enregistrez ce nouveau fichier dans un
endroit bien rangé dans votre ordinateur,
et nommez le intelligemment :
NOMPRENOM — S4 - MORPHO - TD3

Save As...

Envegistrer sous : (_FC-S4-MORPHO-TD3/gh )

Tags :
7 ENSAM - S4 - MORPHO ~

~ | Date de I'ajout Taille

10 janvier 2023 a 18:15
10 janvier 2023 a 18:15

5H.odp février 202

Grasshopper Binary (*gh)

A part ce composant,
supprimez de ce nouveau

Annuler

Nouveau dossier

fichier tous les autres
composants du TD2.

FC-Maillage coque
{l Preview
(W] Enabled
& Bake...
Wire Display
Disconnect

[2] Reverse
Flatten
[ Graft

[7) simplify

Set one Mesh
Set Multiple Meshes

Manage Mesh collection

Clear values
Internalise data

Extract parameter

(@ Help...

Le lien se coupe : le
contenu de ce composant
ne dépend désormais plus
de Rhino ni de précédents
composants

Panel

Panel

OMesh (V:121 F:96)
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Créer un extrados

Pour créer les briques, on commence par décaler le
maillage pour avoir un maillage de I'intrados, et un
maillage de I'extrados. En créant des surfaces entre
ces deux maillages, on obtient le bord des briques.

Weaverbird > Transform > Offset Mesh
Avec Weaverbird, on peut « décaler » un
maillage, c’est a dire en créer un
nouveau dont les faces auront toujours le
méme écart avec le maillage de départ

Weaverbird's Offset Mesh

MORPHOLOGIE - Etude d’une coque simple

Mesh > Analysis > Face Boundaries

Permet d’extraire toutes les faces d’'un
maillage en éléments séparés.

Face Boundaries Surface

Face Boundaries Surface

Pensez a renommer les composants de
début (et de fin) de vos fichiers
Grasshopper !

INITIALES-Description du composant

(clic droit pour renommer)

Paralléle

Sets > Tree > Graft Tree

Permet de séparer les
éléments d’une liste en
autant de branches
séparées.

Ici, on s’assure que les
faces du maillages sont
toutes traitées
indépendamment.

Graft Tree

Surface > Freeform > Loft

Equivalent de la commande
Rhino « SurfaceParSections ».

Permet de créer des surfaces a
partir de courbes dans GH.

C
Sets > Tree > Merge

Permet de rassembler des
données en listes.

Ici, on rassemble la face
du haut et celle du bas en
paires.
Bien faire le clic droi
la borne souhaitée

Ce menu contextuel est différent pour
chacune des bornes.

ur

« Simplify » permet de s’assurer que
Grasshopper n’ajoute pas de
complexité inutile dans sa gestion
des données.

D1

% ENSAM-S4-MORPHO.3dm

. Result as tree

Result of merge

192 locally defined values..
(0) (N =2)
(1) (N =2)
[2 =2
(3} (N =2)
(4) o =2
(5) =2
{6} (N = 2)
(7} W =2
(8) (N =2)
(9) o =2)
4
R —

& Bake...
Wire Display
Disconnect

@ Principal
Reverse
¥ Flatten
Graft

v [¥] Simplify I

Set Data Item...
Set Multiple Data Items...

Manage Generic Data collection

Clear values
Internalise data
Extract parameter

@ Help...
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Aplanir les faces de I'extrados

Une fois les deux couches créées,
on va modifier celle du dessus,
pour s’assurer qu’elles soient toutes
exactement planes.

Pour cela, il faut commencer par
faire de la place sur I'espace de
travail.

On va ensuite extraire les coins de
chaque face. Grasshopper va
trouver pour nous le plan le plus
proche possible de ces 4 points, sur
lequel on va ensuite les projeter
pour ensuite recréer des faces
planes.

[ Tap ALT to toggle separation direction ]

: Maintenez la touche ALT et
glissez pour faire de la place
sur I’espace de travail

Mesh Explode

Face Boundaries

Mesh Explode

de projeter différents types de

% ENSAM-S4-MORPHO.3dm

Plusieurs composants permettent

géométrie, de différentes maniéres,

prenez le bon !

Surface > Analysis >
Deconstruct Brep

Décompose une surface
ou polysurface en ses
différents éléments

Transform > Affine > Project
Permet de projeter n’importe quelle
géométrie sur un plan donné.

Ici, on projette les coins du maillage

erbird's Offset Mesh sur le plan trouvé par GH par Fit Plane

Deconstruct Brep

. Face Boundaries
]

] $ Qutput Mesh/Curves List Iltem

Project 4Point Surface

¢---------
Plane Fit
Vector > Plane > Plane Fit

A partir de plusieurs points,
ce composant créer un plan
moyen, dont chacun

s’éloigne le moins possible.

Sets > List > List Item

Permet d’extraire un ou des
éléments d’'une liste a partir de leur
« adresse » : un nombre entier qui
correspond a leur numéro dans la
liste (appelé Index)

Face Boundari

—4 Mesh W Bound

Surface > Freeform > 4Point Surface

Equivalent de la commande Rhino
SurfaceParPoints, qui permet de
placer successivement les 4 points qui
définissent une surface.

Loft

En zoomant beaucoup
sur'le composant, des
petits + et — apparaissent
pour ajouter des bornes

List Iltem

- List

Index Nb Item D

PR—
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Joindre les différentes surface en une seule polysurface

On va se rassembler sur une seule branche finale les
3 géométries précédemment manipulées : une
surface pou la face intérieure, une surface pour la
face extérieure plane, et une polysurface pour les
bords des briques.

Pensez a renommer les clusters de vos
fichiers Grasshopper !

INITIALES-Description du composant

Weaverbird's Offset Mesh

Mesh/Curves Face Boundaries Surface FC-Aplanir des srfs

Distance $ Output Mesh/Curves Mesh V Boundaries -q

OffsetType

Face Boundaries Graft Tree

Surface

— ) |
— N SA' Il _..\Z(; y % MORPHOLOGIE - Etude d’une coque simple —

{Mesh W Boundaries || ( Tree EE Tree D ’

Les composants de la page
précédente ont été fusionnés
pour créer un nouveau Cluster.

Les Clusters permettent de
réutiliser des bouts de logique,
sans encombrer I'espace de
travail ni la lecture du fichier.

‘ Loft

% ENSAM-S4-MORPHO.3dm

Merge

Sets > Tree > Merge

Permet de rassembler des
données en listes.

Ici, on rassemble la liste
des faces avec le résultat
du Loft qui correspond aux

cotés des briques

Surface > Util > Brep Join

Permet de joindre plusieurs surfaces qui
se touchent en une polysurface (appelée
Brep dans Grasshopper).

Ici, on obtient une polysurface fermée
pour chaque brique

Brep Join

v Breps [)
Closed

Breps

7

D1
& Bake...
Wire Display
Disconnect

@ Principal
[®) Reverse
¥ Flatten
Graft

v [@) Simplify

Set Data Iltem...
Set Multiple Data Items...
Manage Generic Data collection

Clear values
Internalise data
Extract parameter

@ Help...
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Créer une grille sur laquelle étaler les briques

On va se servir de la forme de la coque vue du dessus
pour obtenir une trame de placement des briques qui
permettent de conserver une logique de placement.

Weaverbird's Offset Mesh

FC-Epaisseur briques Mesh/Curves Face Boundaries Surface FC-Aplanir des srfs
eur brigues 020.000 Distance :B Output Mesh/Curves Mesh V Boundaries ) |l ( Brep @ Surface D» em
OffsetType
Face Boundaries Surface Graft Tree I
. vz /

En double-cliquant sur une Transform > Affine > Project

conTQX|on, on peut ctrtee: ges Permet de projeter n'importe quelle Mesh > Analysis > Face Boundaries Params > Geometry > Surface

« relais », qui permettent de PRy . ‘ ) ‘

garder les %rar?chements geométrie sur un plan donne. Permet d’extraire toutes les faces d’un Les composants « hexagones »,

organisés Ici, on projette le maillage de base sur maillage en éléments séparés. permettent aussi de forcer GH a
le plan XY, inclus par défaut dans ce convertir des géomeétries.
composant.

Project

FC-Maillage de base Face Boundaries Surface Is Planar

/. 0 () Slider: FC-Ecartement de la grille )

Properties

FC-Ecartement de la grille

Name FC-Ecartement de la grille _ 02,00+

Expression Transform > Affine > Scale Surface > Analysis > IsPlanar
Grip Style Shape & Text Permet de projeter n'importe quelle Grasshopper étudie la planéité de

lider accuracy géomeétrie sur un plan donné. chaque surface donnée en entrée. Si

rundng R/ N E O Ici, on projette les coins du maillage ‘,’e"T'C' estt (tj)llentpl_ane, il plermst
o sur le plan trouvé par GH par Fit Plane SR ClEUES €3 [MET ¢S

Digits ——]2|————1 référence

Numeric Domain

Min +0oo[o]o[o[o[o]o[1[Jo0]

Max +0]0/0[0[o]o0]o[o]s[llo/}

Range 0]0]0]0/0/0/0[0[0[4{§0]| 0]

Numeric value Attention aux réglages de vos

| EECREERRE BE curseurs. Ici par exgmple,

E I - - 2 'écartement des briques ne sera

lisible que pour un facteur

Cancel supérieur a 1.
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Etaler les briques

On va maintenant positionner a plat toutes les briques
sur la trame définie en p. 8.

On utilise pour cela I'outil Orient, qui permet de donner
un plan de référence source et un plan de référence
cible.

Ici les plans de référence sources vont étre définis par
GH a partir des faces de I'extrados ; et les plans de
référence cibles viennent la grille de placement de la
page précédente.

CMD /CTRL + G Sets > List > List ltem Surface > Analysis > IsPlanar
Srletll Grouper des éléments permet Permet d’extraire un ou des Gr:'aSShOPPr‘fef Et%dle la planelt? de .
v [ Box outline de les placer dans un cadre. éléments d’'une liste & partir @ ﬁxquc_a sut ;\_ce ?nnee_len en rtee. I
& Blob outline Avec les Scribbles, les de leur « adresse » : un gea?;r::st d‘lgst&ﬁgiel p;r:se
@ Rectangle outline groupes améliorent la lisibilité nombre entier qui correspond gf, p
S EEEE—— d’un fichier GH. a leur numéro dans la liste felerennce
ircl (appelé Index)
Add to group . ) Is Planar
Remove from group Face Boundaries Surface FC-Aplanir des srfs
:D Colour > esh W Boundaries D l-l lb -
Make Colour Default Brep
3 , v (& Preview
Face Boundaries Surface Graft Tree ’ (@] Enabled Orient
& Bake...
Wire Display Geometi
Disconnect \ Y Geometry D
Source 5&
(9] Reverse
i i irie L AN
Params > Util > Scribble -
Graft
Permet d’annoter un fichier (@ Simplify & Bake
G -" d I GH pour garder une bonne Set one Brep DiSconnect Transform > Euclidean > Orient
ri e e acement icihilit& Set Multiple Breps . .
P lisibilité. Waos orn alcton : Correspond & la commande Rhino
= Orient.
Clear values
FC-Maillage de base Erolact Scale Face Boundaries Internalise data branar v ¥ Flatten Il permet de déplacer une certaine
- o Extract parameter A Atri H AfA
— e — T — P— [@) Graft géométrie depuis un plan de référence
& @ Help.. " source a un plan de référence cible.
Plane Transform Center 6) [ Simplify
) Factor '
FC-Ecartement de la grille @ Help...
[Fc—é:artement de la grille | 02.00 4

Bien faire le clic droit
sur la borne souhaitée
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FinduTD

- Variez les parameétres ! Les curseurs ou
maillages d’entrée peuvent étre modifiés
facilement.

- Nettoyez votre fichier GH :

- Organisez les connexions proprement

- Masquez I'affichage des éléments
intermédiaires

- Placez les éléments clés dans des groupes

- Utilisez des Scribbles pour commenter
certaines étapes

% ENSAM-S4-MORPHO.3dm

% ENSAM-S4-MORPHO.3dm

LN J

Paralldle

Weaverbird's Offset Mesh

Face Boundaries

(Fo-tpaisseurbriques | 020000 P — y esyCurves p— Mesh [7 Boundaries pemd @) Do Brep () Surface Po ==
14

Face Boundaries Surface Graft Tree ’

(_":—I ‘P:j" ‘F_' '

Grille de placement

FC-Maillage de base Project

Surface

FC-Aplanir des srfs

( Geometry (-
d =

FC-Ecartement de la grille

Liosgol il

b—d Mesh [ Boundaries p=q € .F‘ﬁ.
[

D

MORPHOLOGIE - Etude d’une coque simple

Envoyez plusieurs captures d'écran de votre travail
a l'adresse mail suivante, avec pour OBJET :

NOMPRENOM - S4 - MORPHO - TD3
omi.ensam@ikmail.com

Liste des captures :

- le fichier GH complet des briques

- des vues Rhino des briques dans I’espace et
mises a plat

- I’intérieur du ou des clusters placés

- des vues Rhino d’au moins une variation a partir
du méme fichier GH

% ENSAM-S4-MORPHO.3dm

LN J

Merge

Face Boundaries Surface Is Planar

Merge

ﬁ‘ Loft
! /
ot Tt

(WD

Is Planar

7
[}
]

]

Orient

Geometry -
\ Source sﬂ

Transform

4 P
\ N\
\ Brep Join /' FC-Briques

\

Target
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